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Career Center Services 
ADVISING   

• On-campus, Part-time, Internship, Career search  
• One-on-One Appointments & Drop-in Advising  
• Resume & Cover Letter Reviews  
• Interview Preparation/Practice Interviews  
• Career Fairs, Information Sessions, & Seminars  
• Handshake – platform to search for jobs and internships  
• Career Assessments with Focus2 
• Graduate School 

 

SEMINARS  
• Career & Major Exploration 
• Interviewing with Confidence 
• Networking Strategies 
• Making the Most of Career Fairs 
• Is Graduate School Right for me?! 
• Resumes & Cover Letters Best Practices 
• Job Searching & Who’s Hiring Right Now 
• LinkedIn and Professional Online Presence 

 
EMPLOYERS HIRE CHICO STATE STUDENTS 

Approx. 200 employers send recruiters to Chico State each 
semester to conduct interviews through the Career Center. 
They say “Chico State students have a ready-to-go attitude” 
 

CLASSROOM & CLUB PRESENTATIONS 
To arrange a class presentation, contact Megan Odom 
at modom@csuchico.edu / 530-898-5253, or your primary 
career advisor of your college. 

Presentation options can be customized to your major or 
topic of interest. 

CAREER FAIRS 
• Business Career Fair  
• Career & Internship Job Fair  
• College of Agriculture Career & Internship Fair  
• Education Hiring Fair  
• Graduate & Professional School Fair  
• Health & Social Services Fair 
• Local Job Fair  
• Software, IT & Electronics Fair 
• Technical Career Fair  

 

Visit our website for more details: 
www.csuchico.edu/careers 

 

 

mailto:modom@csuchico.edu
tel:530-898-5253
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Handshake: Internships and Jobs 
 

Handshake is an online recruiting platform for higher education students and alumni. The employers on Handshake are 
working directly with universities to recruit students. 

 All Chico State students have an account pre-set up with basic info (i.e. name/major) 
• Search jobs/internships (on-campus, part-time, internships, & full-time) 
• Register for job fairs, information sessions, and other recruiting events 
• Make appointments with a Career Advisor 

 
HOT JOBS are highlighted opportunities in Handshake selected by your college career advisor. 
 

                

 

 

 

 

 

Major Selection and Career Decision Making 
Focus2 is a major and career exploration platform to help you choose/change a major and 
explore occupations & industries. Highlights include: 

• Assessments in Work Interest, Personality, Values, Skills, and Leisure  
• CSU, Chico majors & 1,000+ occupations to explore with up-to-date career info 
• What can I do with a major in… 
 

 
 

Diversity Career Resources 
Career Diversity Resources are for you to explore in means to find additional support with your 
transition from college to career. Check out our website for resources on the following student 
identities: 

Asian/Pacific American 
Black/African American 
First-Gen 
International  
Latinx/a/o or Hispanic 

LGBTQ+ 
Mature Workers 
Native American 
Neurodivergent 
Seeking International Employment 

Size-Diversity 
Student with disabilities 
Undocumented, Dream, AB 540, DACA 
Veterans 
Womxn-Identified
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Professional Online Presence 
CLEAN IT UP BUILD IT UP 

Google yourself – see unwanted content? See what 
you can delete, or untag yourself from others’ posts 

 
Delete, delete, delete – unprofessional content and 

think like a hiring manager 
 

Manage your privacy settings – ensure your security 
and privacy settings are up-to-date on your profiles 

 
Deactivate older accounts – if you have any social 

media accounts you have stopped using, deactivate 
those accounts 

Create new social media accounts – start new and share 
content publicly that better reflects who you are 

 
Be active – publish quality posts regularly, responding to likes 
and comments on those posts, liking and commenting on your 
followers’ posts, answering direct messages, sharing content 

from other sources, and more 
 

Create your own blog/website – good way to showcase your 
skills and experience and customize to showcase your 

personality 
 

Ask yourself – will you like it five years from now?  
 

  
 

LinkedIn is the world's largest professional 
network with 810+ million users in more than 

200 countries and territories worldwide. 
 

• Create a free account  
• Set up your profile 
• Connect with over 110,000+ alumni 
• Search for internships/jobs 
• Connect with professional associations 
• “Follow” companies of interest 
• Stay up-to-date with the news in your industry 
• Meet 1:1 with a Career Advisor to learn about 

the LinkedIn experience 

LINKEDIN LEARNING IS FREE TO CHICO STATE STUDENTS 
(Access through your portal): 

Complete courses and receive certificates in: 

CREATIVE 
Animation & Illustration 

Audio & Music 
Graphic Design 

Motion Graphics & VFX 

Photography 
Video 

Web Design 
User Experience 

BUSINESS 
Analysis & Strategy 
Software & Tools 
Customer Service 

Finance & Accounting 
Marketing 

Human Resources 
Leadership & Management 

Project Management 
Sales 

Small Business 
Entrepreneurship 

TECHNOLOGY 
Data Science 

Database Management 
Networks & Systems 

DevOps 

Security 
Software Development 

Web Development 
Information Technology 

 
SUGGESTED LINKEDIN LEARNING COURSE: 
“Learning LinkedIn (2022)” by Oliver Schinkten 
 
Discover how to make the most of your LinkedIn account. Follow Oliver Schinkten as he explains 
how to build a stellar LinkedIn profile, and shares how to expand your network, look for new 
career opportunities, join groups, share updates, and contribute your own thought leadership. 
He goes over how to use Creator Mode and Cover Story, as well as how to add your preferred 
pronouns to your LinkedIn profile. 
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Job Search Strategies 
 

PREPARE YOURSELF BEFORE THE SEARCH  REVAMP YOUR RESUME 

Know the labor market – who’s hiring? 
• LinkedIn Economic Graph- Insight into a rapidly 

changing economy 
• O*Net OnLine - Provides broad access to a 

database of occupational information.  
 

 Meet with a Career Advisor 
• Get your resume reviewed for FREE 

Speak the employers’ language 
• Use details from their “job description” to 

enhance your resume/cover letter 
• Create a readable resume that highlights skills 

 

OPTIMIZE YOUR SEARCH KNOW THE EMPLOYER 
Keyword search 

• Try all possible titles. For example, for writing 
jobs you can search for “writer” or you can be 
more specific with “technical writer”, “scientific 
writer”, “copy writer”, etc. 

• Use nouns instead of verbs. Instead of searching 
“engineering”, try its noun “engineer” 

• Search by degree & certifications 
• Search by unique technology expertise 

Use various job board search platforms:  
• Handshake | Indeed.com | LinkedIn | 

Internships.com | Idealist.org | Glassdoor.com 
• Search by Industry or Interest Area  

(https://www.csuchico.edu/careers/students-and-
alumni/get-a-job-or-internship/online-job-postings.shtml) 

• Bookmark/save posts you like 
• Use job alerts to automatically receive new job 

postings  

Make your resume public 
• Various sites allow you to upload a resume for 

employers to see so they can find you 
• Have your resume reviewed by your Career 

Advisor!  
 
        

Do your research 
• Visit the company website 

o  “About Us” & “News and Press Release” 
• Check the company’s social media 
• Read anonymous company reviews on 

Glassdoor.com 
• Google search the name of the company 

 

NETWORK INTO THE NEXT OPPORTUNITY 
U.S. Bureau of Labor and Statistics concludes that 85% 
of jobs are filled by networking. Here are ways to 
network: 
Attend employer recruiting events 

• Career Fairs 
• Company Information Sessions 

o Listed on Handshake “Events” 

Connect with alumni 
• Over 111,000+ Chico State alumni on LinkedIn 

o Inquire about their company 
o Ask for some insider information 
o Set up an informational interview 
o Find recruiters to help with openings you 

want to apply for 

Get involved 
• Join a professional association 
• Join on-campus student clubs/organizations 

Seek mentorship 
• Conduct informational interviews 
• Connect with faculty 
• Use your personal networks 

Ask for a referral 
Ask your friend or connection to refer you to their 
employer and pass along your resume 

FINANCIAL WELLNESS CLINIC 
Budgeting 
Investing 

Financial Planning 
 

Make an appointment 
for free assistance 

https://economicgraph.linkedin.com/?trk=eg_fow_cp_nav
https://www.onetonline.org/
https://csuchico.joinhandshake.com/login
https://www.indeed.com/
https://www.linkedin.com/login
https://www.internships.com/
https://www.idealist.org/en
https://www.glassdoor.com/index.htm
https://www.csuchico.edu/careers/students-and-alumni/get-a-job-or-internship/online-job-postings.shtml
https://www.csuchico.edu/careers/students-and-alumni/get-a-job-or-internship/online-job-postings.shtml
https://www.csuchico.edu/careers/students-and-alumni/get-a-job-or-internship/online-job-postings.shtml
https://www.csuchico.edu/careers/students-and-alumni/get-a-job-or-internship/online-job-postings.shtml
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What Employers Seek (2023) 

 

 

 

 

 

 

 

 

 Skill Statements (“bullet points” on a Resume) 

LEVELS OF A SKILL STATEMENT: 
Basic: Demonstrated excellent communication skills by waiting on tables. 

Advanced: Greeted customers and placed orders while clearly communicating with patrons, staff, and managers. 

Adv. Results: Served customers by accurately communicating food orders while increasing sales by 10%. 

PROCESS 

1. Think of a POWER/ACTION VERB 
Present experience = PRESENT tense 
Past experience = PAST tense 

2. Think of a TRANSFERABLE SKILL you: 
a. Have used 
b. Have gained/acquired 
c. Can offer 

3. Ask yourself: TASK/RESULT 
a. How did I gain or use this 
skill? 
b. Why or for what reason? 
c. To what extent? (results) 

POWER/ACTION VERB + TRANSFERABLE SKILL + TASK/RESULT 
Provided + outgoing and friendly service + while fulfilling complex and detailed catering orders 
Demonstrated + leadership skills + which led to promotion opportunities 
Created + Pivot Tables in Excel  + to present company data to executive committee 

0.0% 50.0% 100.0%

Communication
Critical Thinking

Teamwork
Equity & Inclusion

Professionalism
Technology

Career & Self Development
Leadership

89.8%
89.2%
87.4%
85.8%
84.6%

80.6%
76.2%

73.0%

EMPLOYERS RATE THE IMPORTANCE OF 
CAREER READINESS COMPETENCIES

0.0% 50.0% 100.0%

Fluency in a foreign language
Entrepreneurial skills/risk-taker

Friendly/outgoing personality
Tactfulness

Creativity
Strategic planning skills

Organizational ability
Interpersonal skills (relates well to others)

Leadership
Computer skills

Communication skills (verbal)
Detail-oriented

Initiative
Technical skills

Communication skills (written)
Analytical/quantitative skills

Strong work ethic
Ability to work in a team

Problem-solving skills

3.7%

9.3%

14.6%

15.9%

17.5%

24.4%

33.3%

39.8%

43.9%

44.7%

46.3%

47.6%

48.0%

50.0%

50.0%

50.4%

52.4%

61.0%

61.4%

ATTRIBUTES EMPLOYERS SEEK 
ON A CANDIDATES RESUME

Use these Transferable Skills 
to highlight on your 

resume… 
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Power/Action Verbs 
LEADERSHIP | MANAGEMENT 
Aligned 
Chaired 
Controlled 
Coordinated 

Cultivated 
Directed 
Enabled 
Evaluated 

Executed 
Facilitated 
Fostered 
Guided 

Headed 
Hired 
Inspired 
Instructed 

Mentored 
Mobilized 
Motivated 
Operated 

Orchestrated 
Organized 
Oversaw 
Planned 

Produced 
Programmed 
Recruited 
Regulated 

Shaped 
Supervised 
Taught 
Trained 

Unified 
United

CREATED | DESIGNED 
Abstracted 
Acted 
Adapted 
Administered 

Began 
Built 
Charted 
Combined 

Composed 
Conceptualized 
Condensed 
Created 

Customized 
Designed 
Developed 
Devised 

Directed 
Displayed 
Drew 
Founded 

Engineered 
Entertained 
Established 
Explored 

Fashioned 
Formalized 
Formed 
Formulated 

Implemented 
Incorporated 
Initiated 
Instituted 

Introduced 
Launched 
Pioneered 
Spearheaded 

ORAL/WRITTEN COMMUNICATION 
Addressed 
Advertised 
Advised 
Advocated 
Arbitrated 
Argued 
Arranged 
Articulated 
Authored 

Briefed 
Clarified 
Closed 
Coached 
Collaborated 
Communicated 
Composed 
Concluded 
Condensed 

Conferred 
Consulted 
Contracted 
Conveyed 
Convinced 
Corresponded 
Created 
Debated 
Defined 

Developed 
Directed 
Discussed 
Dispatched 
Distinguished 
Drafted 
Edited 
Educated 
Elicited 

Enlisted 
Explained 
Expressed 
Fielded 
Formulated 
Furnished 
Helped 
Identified 
Incorporated 

Influenced 
Informed 
Interacted 
Interpreted 
Interviewed 
Involved 
Joined 
Judged 
Led 

Lectured 
Listened 
Manipulated 
Marketed 
Mediated 
Moderated 
Motivated 
Merged 
Negotiated 

Observed 
Obtained 
Outlined 
Participated 
Persuaded 
Presented 
Promoted 
Proposed 
Publicized 

Read 
Reasoned 
Reconciled 
Recruited 
Referred 
Reinforced 
Reported 
Resolved 
Responded 

Sold 
Solicited 
Specified 
Spoke 
Suggested 
Summarized 
Synthesized 
Translated 
Wrote 

TEAMWORK | COLLABORATION 
Advised 
Advocated 
Aided 

Assisted  
Clarified 
Corresponded 

Collaborate  
Contribute  
Cooperate  

Coordinate  
Defined 
Enabled 

Encouraged 
Facilitated 
Fostered 

Helped  
Informed 
Inspired 

Interpreted 
Involved  
Participated  

Persuaded 
Provided 
Publicized 

Referred 
Resolved 
Shared  

Supported  
Upheld 
 

TECHNICAL 
Acclimated 
Activated 
Adapted 
Adhered 
Adjusted 
Applied 
Assembled 
Automated 

Balanced 
Built 
Calculated 
Centralized 
Channeled 
Charted 
Circulated 
Computed 

Conceived 
Conserved 
Constructed 
Converted 
Coordinated 
Debugged 
Deferred 
Demonstrated 

Designed 
Detected 
Determined 
Developed 
Devised 
Diagrammed 
Diversified 
Drafted 

Engineered 
Excelled 
Expanded 
Expedited 
Fabricated 
Formed 
Fortified 
Generated 

Improved 
Increased 
Installed 
Interfaced 
Launched 
Maintained 
Mastered 
Modified 

Molded 
Networked 
Operated 
Overhauled 
Packaged 
Pioneered 
Prepared 
Printed 

Processed 
Programmed 
Rebuilt 
Reconstructed 
Rectified 
Re-designed 
Re-engineered 
Regulated 

Remodeled 
Repaired 
Replaced 
Restored 
Revamped 
Solved 
Specialized 
Standardized 

Streamlined 
Studied 
Surveyed 
Systematized 
Upgraded 
Utilized 
Wrote 
 

CRITICAL THINKING | RESEARCH 
Analyzed  
Arranged 
Assembled 
Assessed 
Audited 

Calculated 
Catalogued 
Clarify 
Classified  
Collected  

Compared  
Compiled 
Conducted 
Critiqued  
Detected  

Discovered 
Evaluated  
Examined 
Explored 
Forecasted 

Generated 
Highlighted  
Identified 
Implemented 
Inspected 

Interpreted 
Investigated 
Mapped 
Measured 
Monitored 

Organized 
Persuaded 
Prepared 
Proposed  
Proved  

Qualified 
Quantified 
Recorded 
Retrieved 
Screened 

Simulated 
Specified 
Studied  
Surveyed 
Systemized 

Tested 
Tracked 
Trained 
Transmitted 
Validated

SOCIAL SERVICE | TEACHING 
Accommodated 
Achieved 
Adapted 
Adjusted 
Advised 
Advocated 
Aided 

Alleviated 
Answered 
Arbitrated 
Arranged 
Assessed 
Assisted 
Assured 

Attended 
Augmented 
Bolstered 
Cared 
Clarified 
Coached 
Collaborated 

Consoled 
Contributed 
Cooperated 
Counseled 
Demonstrated 
Developed 
Sensitivity 

Diagnosed 
Directed 
Eased 
Educated 
Elevated 
Encouraged 
Endorsed 

Ensured 
Expedited 
Facilitated 
Familiarized 
Fostered 
Furthered 
Guided 

Helped 
Integrated 
Insured 
Interceded 
Intervened 
Led 
Listened 

Mentored 
Mobilized 
Motivated 
Perceived 
Preventive 
Protected 
Provided 

Referred 
Rehabilitated 
Related 
Rendered 
Represented 
Resolved 
Safeguarded 

Serviced 
Simplified 
Spoke 
Supplied 
Supported 
Volunteered 
 

SALES  
Accelerated 
Achieved 
Advanced 

Amplified  
Boosted 
Capitalized 

Conserved 
Consolidated 
Decreased 

Deducted 
Delivered 
Diagnosed 

Enhanced 
Expanded 
Expedited 

Furthered 
Gained 
Generated 

Improved 
Lessened 
Lifted 

Maximized 
Outpaced 
Reconciled 

Reduced 
Stimulated 
Sustained 

Yielded
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Formatting Tips 

 
 

 

 
 

HOW TO ADD A BORDER/LINE 
(1) Highlight the line to add a border. 

(2) Click on Borders and Shading to select style preference 

“Home” > Go to Paragraph section > click  
> Click “Borders and Shading” > select style preference 

Go to “Format” > Click “Paragraph Styles” 
> Click “Borders and Shading” > select style & click “Apply” 

HOW TO RIGHT JUSTIFY DATES 

  

Go to “View” > Check “Ruler”  > Click the tab stop 
(leftmost edge of ruler) until you see a Right Tab “ ” > Add Right 
Tab with a left click on the ruler > Drag Right Tab to align dates 
with right margin > Place your cursor in front of your dates > click 
the “tab” key on your keyboard to right justify 

Go to “View” > Click “Show Ruler” > Right-click 
on ruler > click on “Add right tab-stop” > Drag 
Right Tab “ ” to align with right margin > Place 
your cursor in front of your dates > click the 
“tab” key on your keyboard to right justify 

Tab Stop 

 
  

  

WAYS TO SAVE SPACE 

  
MARGINS (.5”-1”) 

Go to “Layout” > “Margins” > OPTIONS: click on default 
setting options (i.e. “narrow”) or “Custom Margins” > 
Adjust Left/Right/Top/Bottom to preference - (.5”-1”) 

Go to “File” > click on “Page Setup” 
> Adjust Left/Right/Top/Bottom to preference - (.5”-1”) 

LINE SPACING (“single-spacing” is standard for resumes) 

Go to “Home” > Click Line & Paragraph Spacing icon  
> click on “1.0” OR “Line Spacing Options” 

Go to “Format” > Click “Line & Paragraph Spacing” > Click 
“Single” OR “Custom Spacing” 

HOW TO ADD OR REMOVE SPACE (above or below a line) 

“Line Spacing Options” (with 0 pt before/after): “Custom Spacing” (with 6 pts after): 

 

Title, Company (Location) Dates 
• Skill statement 
• Skill statement 
• Skill statement 

 Title, Company (Location) Dates 

• Skill statement 
• Skill statement  

Example: 
EDUCATION 

Example: 
Job Title, Company Name (City, State)     Month Year 

 

<<< Add Right Tab >>> 

<<< Drag Right Tab >>> 
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 General Resume Guidelines 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EDUCATION: This section is at 
the top if recent/new 
graduate. Optional: add 
cumulative GPA if higher than 
3.0. Content can include - 
community college, study 
abroad, coursework, 
certificates, athletics, & 
languages (include level of 
proficiency or seal of bi-
literacy). 

EXPERIENCE: Separate 
information by using (bold, 
underline, italics, CAPS, (), 
etc.) Retitle section headers to 
represent your experience 
(Volunteer, Campus 
Involvement, Customer Service 
Experience, Research, etc.). 
List in reverse chronological 
order. Follow a consistent 
format within each section.  

Include title, company/organization, 
location, and date range 

NAME: Font Size 16-24  

OPTIONAL: LinkedIn and/or 
web address; Location can be 
full address or City, State  

ACADEMICS: A project or 
research section can 
demonstrate how you apply 
your knowledge to the world 
of work. Content can include 
the project/research title, 
organization, your role, 
location, etc.; include the skill 
set you gained or utilized.  

SKILLS: Insert skills directly 
relevant to the 
industry/position (i.e. 
computer hardware/software 
skills, technology skills, 
programming skills, industry 
specific machinery) 

GENERAL TIPS:  
Margins .5”-1”  
Font: Size (10-12), Type (use a basic font - Times New Roman, Arial, Calibri, etc.) 
Font Color: Black text is a standard; using color sparingly can be acceptable 
Line Spacing: standard is “single spacing” 
Columns:  a simple way to list items and reduce amount of vertical space used  
Bullets: use a bullet format to list your “skill statements”; avoid paragraphs 
Balance the page: avoid white space, aligning dates to the right, etc. 
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Resume Sample with Limited Experience  
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Sample Resume 
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 Sample Resume 
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Sample Resume 
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Sample Resume 
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Sample Resume 
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Sample Resume 
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Sample Resume 
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Sample Resume 
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Curriculum Vitae Sample 
Curriculum Vitae (CV) is Latin for "course of life." In contrast, resume is French for "summary." 

CV’s are most common in Europe. CV’s in the US are used typically in academia. 
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Curriculum Vitae Sample 



  

20   California State University, Chico   
 

Cover Letter Guidelines 

Aiden Hayes 
Chico, CA | (530) 123-1234 | AHayes123@gmail.com 

 
 
February 17, 2022  
 
 
Tesla Headquarters 
3500 Deer Creek Road 
Palo Alto, CA 94304 
 
Re: Job #AE24963 
 
Dear Hiring Team,  
 
I am excited to submit my application for the Application Engineer position I saw listed on 
LinkedIn. I am inspired by Tesla’s mission to accelerate the world’s transition to 
sustainable energy. Furthermore, as a Latino, I love that Tesla values diversity and 
inclusion, and can appreciate my unique perspective and insights that I would bring to their 
team. I am confident that my relevant education, experience, and skills related to this 
position merit your consideration.  
 
With a solid software engineering background and vast skill set, I am certain that I will be 
an exceptional asset to Tesla. In my senior project, I developed a deployment framework 
mainly in Python to automate the metering process of analog water meters via internet, by 
means of computer vision and machine/deep learning. The solution created was so 
impactful that it is being integrated into the laboratory of water-meter calibration of the 
environmental sanitation company in Mexico, TECMA, and was submitted by my mentor 
and me for publishing.  
 
Through this project, I was able to apply my knowledge of HTML, CSS, and JavaScript to 
achieve real-time remote supervision of water usage, transforming the water-metering 
process in Mexico. Shell scripting was used to deploy the software into Linux-based 
machines. Additionally, in my scientific article, the statistical data analysis, probability 
models, and plotted graphics were all carried out in R. In the same way I utilized multiple 
languages to create a software solution for TECMA, I will implement my broad knowledge 
at Tesla to pioneer software that brings high performance and sustainable value to clients.  
 
Although the enclosed resume thoroughly outlines my education and experience, I would 
appreciate the opportunity to demonstrate in an interview how my engineering knowledge 
duly fits the qualifications you are seeking. I will follow up by phone in two weeks to see 
if there is any additional information you would like me to provide. Thank you for your 
time and interest.  
 
Sincerely,  
 
 

Aiden Hayes  

Date 

Recipient Name 
Title 
Company Name 
Street Address 
City, State, ZIP 

INTRO PARAGRAPH: Hook 
the reader and briefly 
introduce yourself. You can 
include the job title, your 
degree, and how your 
experience makes you a 
good fit. This is your chance 
to show the employer that 
you have read the job 
description and have 
researched the company.  
 
Know someone from the 
company? Include them 
here. 

BODY PARAGRAPHS: 
Identify the employer’s 
desired skillsets. 
 
Give clear and concise 
examples of 
experiences/skills you have 
that make you a great fit for 
the position. TIP: use 
keyword/qualifications from 
the job description. 

CLOSING PARAGRAPH: 
Reiterate your interest, 
thank the employer and end 
with a call to action:  
Passive Example: “I look 
forward to hearing from 
you!” 
Active Example: “I look 
forward to interviewing with 
you to discuss my 
qualifications” 

NOTE: If you do not know 
how to address the 
recipient, try calling HR for 
details, OR use “Dear Hiring 
Committee/Team/Manager” 
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Reference Page Sample 
 

 

 

 

 

 

 

 
 

Email Introductions / Thank You Etiquette 

  

POSSIBLE REFERENCES: former supervisors, faculty, 
others who are qualified to comment on your work 
habits, achievements, personal qualifications, etc. 

OPTIONAL: your contact info can be the same as your 
resume header  

INFORMATION YOU CAN INCLUDE:  
Name, Title, Organization, Address, Phone Number, 
Email, Relationship, etc. 

ADDITIONAL TIPS:  
 Check in with your references and confirm 

preferred contact information 
 Inform them about your career objectives and 

what qualities to emphasize 
 Keep your references posted on your progress 
 Send a THANK YOU letter! 

EMAIL INTRODUCTIONS: 
EXAMPLE #1: 

Dear Hiring Professional, 

I am excited about applying for your open Account Representative position in your 
Sacramento office (req. #45678). My experience includes a proven three-year track 
record in retail sales where I was consistently ranked as a top performer. My 
attached resume and formal cover letter further explain my qualifications, including 
my bachelor’s degree in marketing from California State University, Chico. I look 
forward to hearing from you. Thanks! 

EXAMPLE #2: 
Dear Mr. Jones,  

Please accept my attached cover letter and resume in consideration for your entry-
level Biologist position. I will graduate in May with a bachelor’s degree in biology, 
achieving a 3.6 GPA while working 30 hours a week. I look forward to hearing from 
you to further discuss my qualifications. Thanks for your consideration. 

EXAMPLE #3: 
Dear Terry,  

As a Yuba City native, I was very excited to see your posting for an entry-level social 
work position, as I feel connected to the area and the population. I will receive my 
MSW from Chico State in December and look forward to hearing from you and 
discussing how I can put my degree to work at your agency. Attached is my resume 
and cover letter. Thank you. 

THANK YOU ETIQUETTE: 
WHAT TO INCLUDE: 
 Remind them who you are, and 

how/where you met 
 Be memorable and try to include a 

unique detail to stand out 
 Avoid a generic thank you note 
 Reiterate your interest in the 

job/organization 
 Remind them of your qualifications 
 Sincerely thank them for their time 
 Give them your contact information 
 Keep it brief 

WHEN TO WRITE A THANK-YOU NOTE: 
It is ideal to write and send a thank-you 
note within 48 hours of: 

 Interviews 
 Career fairs 
 An encounter with a recruiter or 

professional 
 Informational interviews 
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 Career Fair 

 
 

Premier Partners 

BEFORE THE FAIR: DURING THE FAIR: AFTER THE FAIR: 

 Do your research on employers!
 Attend a Career Fair Prep

Seminar
 Meet with your Career Advisor

or come to Drop-In Advising to
review your resume

 Print plenty of copies of your
resume

 Practice your introduction
(“elevator pitch”)

 Plan what to wear

 Be prepared. Visit all employers
that interest you.

 Take notes and gather information.
 Leave your resume with potential

employers, & ask for a business
card to follow up with them.

 Ask about upcoming opportunities,
deadlines, and the hiring process.

 Dress for success. Pretend it’s your
first interview for your dream job!

 Leave bulky bags at home.
 Carry a small bag/folder to hold

resumes & any info gathered.

 Follow up with your contacts
and provide any additional
information

 Continue to practice your
interviewing skills

 Send a thank you note/email to
employer

 Take action on any further
instructions you were given by
an employer

 Attach resume whenever
possible for convenience to the
employer

Career Fair details on our website: 
www.csuchico.edu/careers 

Whether it’s securing a job interview, finding out where to apply, networking, exploring the job market, or 
simply gaining practice talking to employers, most students benefit greatly from career fairs.  

All majors and class levels are welcome! 

http://www.csuchico.edu/careers
https://www.cintas.com/careers
https://cedcareers.com/
https://www.google.com/aclk?sa=l&ai=DChcSEwjE1pbQoJH_AhXBBOcKHQHyAJIYABAAGgJwdg&ase=2&sig=AOD64_0O94L_FjaPYNQruwE-aC0AjtF7CQ&q&nis=4&adurl&ved=2ahUKEwiW6o7QoJH_AhVKLUQIHS4cDw0Q0Qx6BAgGEAE
https://www.federatedinsurance.com/careers
https://careers.chevron.com/
https://careers.enterprise.com/
http://tticareers.com/
https://www.google.com/aclk?sa=l&ai=DChcSEwjw6Za3pJH_AhUzBq0GHZISAfoYABAAGgJwdg&ase=2&sig=AOD64_1Ka87ZTnaTP_dpH2mQYQ2C0ZzM3w&q&nis=4&adurl&ved=2ahUKEwiI5pC3pJH_AhWcIEQIHfr5DqQQ0Qx6BAgGEAE
https://www.pepsicojobs.com/
https://www.flexcarestaff.com/careers-flexcare
https://careers.thehersheycompany.com/
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Interviewing Guidelines 

 

COMMON QUESTIONS: 

1. Tell me about yourself. Focus on your
experience and academics. Avoid a
life story. Use your resume as a
foundation.

2. Why are you interested in this job?
Great chance to distinguish yourself.
Incorporate research you have done
about the organization into your
answer. This shows you have invested
time into learning about their
operations, goals, and values. It is
also important to show how your
qualifications or interests make you
an asset to the organization.

3. What do you know about our
organization? Make sure you have
researched the organization.
Demonstrate how you align with
them (i.e. values, goals, mission, etc.)

4. What is your greatest strength?
Tailor your answer to the job. For
instance, if one of your strengths is
leadership and you are applying for a
sales job, show how your
motivational skills work in both
situations.

5. What is your greatest weakness?
Focus on a skill you want to improve
upon AND provide an example of
what steps you are taking to develop
that skill set.

6. Why should we hire you? Focus on
what your particular contribution will
be to company success: hard work,
dedication, humor. We all bring
something unique.

QUESTIONS TO ASK THE EMPLOYER: 
Always have at least 2-3 questions prepared for your interview... 

1. What are your expectations for the person you hire?
2. What kinds of projects might I be working on?
3. Why do you like working for this company?
4. How would you describe the typical training program?
5. How is the company structured in terms of departments or

divisions?
6. Please describe the travel involved in this position.
7. What opportunities do you see for growth and development?
8. I am very interested in this position—what is the next step?

BEHAVIORAL INTERVIEWING: 

BEFORE THE INTERVIEW 
Review resume | Research the company 

| Practice interview | Prepare 
clear/concise examples of your skills | 

Plan attire 

DAY OF INTERVIEW  
Arrive early | Portfolio (extra copies of 
resume, note pad, pen, references) | 

Positive affirmations 

AFTER THE INTERVIEW 
Provide a THANK YOU (note, email, etc.) | Follow up 5 days after the interview 

Situation

Briefly describe 
the situation 

you were 
involved in.

DURING THE INTERVIEW  
Connect with interviewer(s) - handshake, 

eye contact, smile | Focus on relevant 
skills | Provided examples of skills 
(S.T.A.R) | Ask employer questions 

Task

What task(s) 
did you need to 

accomplish? 

Action

Specifically, 
what action(s) 
did you take? 

Result

What is the 
positive result 

of your 
actions? 

SAMPLE BEHAVIORAL QUESTIONS - Use S.T.A.R. to respond to “tell me 
about”, “describe”, and “give an example when” questions: 

1. Tell me about an accomplishment from the past year you are the
most proud of? Why?

2. Give an example of a time you saved an employer time or money.
3. Please describe a situation where you used creativity to solve a

problem.
4. Tell me about a time you went the extra mile to help a customer.
5. Describe a situation where you gathered and analyzed facts to

arrive at a decision.
6. Tell me about an experience when you dealt with an upset

customer or co-worker.
7. Give me an example of a high-pressure situation you have faced

this past year and how you resolved it.
8. Give me an example of a time you showed initiative and took lead.
9. Tell me about a time when you delegated a project effectively.

Find more interview sample 
questions on our website 
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International | Study Abroad/Away 
In today’s globalized world, employers in all fields search for candidates with 
career readiness competencies that can be gained through global experiences. 
Check out the tips below on how to showcase your experience on your resume to 
gain an employment edge.  

TOP SKILLS GAINED THROUGH GLOBAL EXPERIENCES: 

• Adaptability (to new culture) 
• Learns from diverse cultures 
• Handles ambiguity 
• Flexibility 
• Focused under pressure 
• Organized 

• Interpersonal 
• Creative Problem Solving 
• Demonstrates inclusiveness 
• Leadership  
• Communicates across cultures 
• Course/major related knowledge 

 
 
 
 

STRATEGIES FOR INTERNATIONAL STUDENTS SEEKING U.S. EMPLOYMENT:  

1.  Start early by speaking with an Advisor from International Student Services and Career Center 
2.  Plan ahead to apply for OPT/CPT/Work authorizations. This takes time to get approved (at least 90 days) 
4.  Attend a workshop with International Student Services (https://www.csuchico.edu/iss/)  
5.  Make a professional online presence via Handshake, LinkedIn, etc. (OPT/CPT search options available) 
6.  Attend Career Fairs & Seminars offered through the Career Center (https://www.csuchico.edu/careers) 
7.  Network by speaking with friends, alumni, professors, staff, clubs, professional associations, etc.  

 

Graduate School 
IS GRADUATE SCHOOL FOR YOU? 

• Does the career you are preparing for require an advanced degree? 
• Are you financially prepared? 
• Is there an advantage to work first and then return to school? 
• Are there other options that you should consider? 

 
RESOURCES FOR GRAD SCHOOL: 

• Before Applying 
• Putting Together Your Application 
• Graduate School Interview Questions 
• After Admittance 
• International Graduate Programs  

  

Learn more about 
skills gained through 

global education 

Watch information videos, including 
“Personal Statements” for guidance 
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